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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Change the Font Face and Font Size for Selected Text
	5-1
	Select the required text. Select a font face from the Font drop-down list.
Select a font size from the Font Size drop-down list.

Alternatively, use the Increase Font Size and Decrease Font Size buttons on the Formatting toolbar.
	Health1.ppt
	None

	Apply Bold, Italic, and Text Color
	5-2
	Select the text. Use the keyboard shortcuts:
[Ctrl]+[B] for bold

[Ctrl]+[I] for italic

[Ctrl]+[U] for underline

Select the text. Use the Font Color button on the Formatting toolbar to change the text color.
	None
	None

	Use the Font Dialog Box
	5-3
	Right-click the selected text to display the shortcut menu. Choose Font to open the Font dialog box. Select appropriate options.
	None
	Sol-5-3.ppt

	Change the Case of Selected Text
	5-4
	Select the text. Press [Shift]+[F3].
Alternatively, choose Format, Change Case. Choose a casing option from the Change Case dialog box.
	None
	None

	Replace Presentation Fonts
	5-5
	Choose Format, Replace Fonts.
	None
	None

	Select a Text Placeholder
	5-6
	Click the border of an active placeholder with the four-pointed arrow. Press [Esc] while a placeholder is active. Press [Tab] to select the next placeholder on the slide.
	None
	Sol-5-6.ppt

	Change Text Alignment
	5-7
	Select the text. Choose Format, Alignment. Select appropriate options.
Alternatively, use the alignment buttons on the Formatting toolbar.
	None
	None

	Use the AutoFit Feature
	5-8
	Choose Tools, AutoCorrect Options. Click the AutoFormat As You Type tab. Under Apply as you type, check the AutoFit title text to placeholder and AutoFit body text to placeholder options.
	None
	Sol-5-8.ppt

	Change the Size of a Placeholder by Dragging a Sizing Handle
	5-9
	Select the placeholder. Position the pointer over the bottom center sizing handle. When the pointer changes to a two-pointed vertical arrow, hold the left mouse button and drag the sizing handle to the desired location.
	None
	None

	Move a Placeholder by Dragging Its Border
	5-10
	Select the body text placeholder. Position the pointer over the placeholder border anywhere except on a sizing handle. The pointer changes to a four-pointed arrow. Drag the four-pointed arrow.
	None
	None

	Use the Format Placeholder Command
	5-11
	Right-click anywhere in the body text placeholder and choose Format Placeholder from the shortcut menu. Select appropriate options from the Format AutoShape dialog box.
	None
	Sol-5-11.ppt

	Turn Bullets On and Off
	5-12
	Select the entire placeholder by pressing [Esc]. Click the Bullets button on the Formatting toolbar.
	None
	None

	Change the Color and Shape of a Bullet
	5-13
	Right-click the placeholder border. Choose Bullets and Numbering. In the Bullets and Numbering dialog box, click the Bulleted tab. Select a color from the Color box. Click the Customize button to select a shape for the bullet.
	None
	None

	Create a Bullet from a Picture
	5-14
	Open the Bullets and Numbering dialog box, click the Bulleted tab, and then click Picture. Click Import. Navigate to the location of the picture file in the Add Clips to Organizer dialog box. Select the file. Click Add.
	None
	Sol-5-14.ppt

	Create Numbered Paragraphs
	5-15
	Press [Esc] to select the placeholder. Open the Bullets and Numbering dialog box and click the Numbered tab. Select appropriate options.
	None
	Sol-5-15.ppt

	Change Text Formatting on Master Slides
	5-16
	Choose View, Master, Slide Master. Make the requisite changes to the master slide.
	None
	None

	Reapply a Slide Layout
	5-17
	Choose Format, Slide Layout. Display a slide. Right-click the Title Slide layout in the Slide Layout task pane and choose Reapply Layout from the shortcut menu.
	None
	Sol-5-17.ppt

	Add Text by Using a Text Box
	5-18
	Click the Text Box button on the Drawing toolbar. Key the text.
	None
	None

	Change Font and Color
	5-19
	Select the text box border to select the text box. Change the font face and the font size. Use the Font Color button to change the text color.
	None
	None

	Wrap Text in a Text Box
	5-20
	Draw a text box using the Text Box button. Key the text. Drag the pointer to define the width of the text box. Word wrapping is automatically turned on.
	None
	None

	Rotate a Text Box
	5-21
	Drag the green rotation handle that appears at the top of a selected object. Position the text box at the desired rotation angle.
	None
	Sol-5-21.ppt

	Change font size, apply text attributes to selected text, and change the case of selected text.
	5-22
	
	ComWalk.ppt
	Sol-5-22.ppt

	Change a font face, apply text attributes to text placeholders and selected text, and work with bullets.
	5-23
	
	PwrWalk1.ppt
	Sol-5-23.ppt

	Change font size, apply text attributes, change text alignment, and change size and position of placeholders.
	5-24
	
	PwrWalk1.ppt
	Sol-5-24.ppt

	Work with the presentation master slides and work with text boxes.
	5-25
	
	PwrWalk2.ppt
	Sol-5-25.ppt

	Apply text attributes to selected text and placeholders, work with bullets, resize and reposition placeholders, and make changes to the slide master.
	5-26
	
	FoodCon.ppt
	Sol-5-26.ppt

	Apply text attributes to selected text and text placeholders, replace fonts, work with bullets, and the slide master.
	5-27
	
	WasteMgt.ppt
	Sol-5-27.ppt

	Apply text attributes to selected text and text placeholders, align text, work with bullets, resize and reposition placeholders, and work with the slide master.
	5-28
	
	PwrWalk3.ppt
	Sol-5-28.ppt

	Apply text attributes to text and text placeholders, work with bullets, change alignment, resize and reposition placeholders, and work with the slide master.
	5-29
	
	Sponsor1.ppt
	Sol-5-29.ppt

	
	5-30
	
	None
	None

	
	5-31
	
	None
	None

	
	5-32
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 5.1

Working with Fonts
This section focuses on:

· Changing the Font Face and Font Size for Selected Text

· Applying Bold, Italic, and Text Color

· Using the Font Dialog Box

· Changing the Case of Selected Text

· Replacing Presentation Fonts

Section 5.2

Applying Text Formatting to Placeholders

This section focuses on:

· Selecting a Text Placeholder

· Changing Text Alignment

· Using the AutoFit Feature

Section 5.3

Changing Size and Position of Text Placeholders

This section focuses on:

· Changing the Size of a Placeholder by Dragging a Sizing Handle

· Moving a Placeholder by Dragging Its Border

· Using the Format Placeholder Command

Section 5.4

Working with Bullets

This section focuses on:

· Turning Bullets On and Off

· Changing the Color and Shape of a Bullet

· Creating a Bullet from a Picture

· Creating Numbered Paragraphs

Section 5.5

Modifying a Design Template’s Text Placeholders

This section focuses on:

· Changing Text Formatting on Master Slides

· Reapplying a Slide Layout

Section 5.6
Working with Text Boxes

This section focuses on:

· Adding Text by Using a Text Box

· Changing Font and Color

· Wrapping Text in a Text Box

· Rotating a Text Box

	Lecture Outline
	Lecture Notes

	Working with Text
Users can change the way text appears in a PowerPoint presentation. This can be done before or after keying text on a slide. Changes can be applied to the entire text in a presentation at once by applying changes to the master slide.

Section 5.1

Working with Fonts
The appearance of text can be changed by changing the font. A font is a set of characters with a specific design. Users can change the font face and the font size. Fonts are measured in points, where 72 points make up an inch. Fonts of equal size may occupy different amounts of horizontal space.

Users can change the appearance of text by applying text attributes. Users can apply text styles (such as bold or italic) and effects (such as underline or shadow) using the Formatting toolbar or the Font dialog box.

Changing the Font Face and Font Size for Selected Text

The Font list box on the Formatting toolbar displays all the fonts available on a user’s computer. The left side of each font displays a symbol indicating the font type. If a presentation is to be shown on a different computer or is to be printed with a different printer, a TrueType font should be used.
The Increase Font Size and Decrease Font Size buttons on the Formatting toolbar increase the size of all the text in a selected placeholder by one font size. If there are several sizes of text in the placeholder, each size is changed proportionately.
Applying Bold, Italic, and Text Color

The keyboard shortcuts for applying bold, italic, and underline text formatting are:
· [Ctrl]+[B] for bold

· [Ctrl]+[I] for italic

· [Ctrl]+[U] for underline

The Font Color button on the Formatting toolbar is used to change the text color.
Using the Font Dialog Box

The Font dialog box can be used to apply several font attributes at the same time. It can be used to select:
· Fonts
· Font styles
· Font sizes
· Text effects
· Text colors
Right-clicking the selected text and selecting Font from the shortcut menu opens the Font dialog box.
Changing the Case of Selected Text

The Change Case command, which can be accessed from the Format menu. Users can change the text to:

· Sentence case

· Lowercase

· Uppercase

· Title case

· Toggle case

Users can also cycle through uppercase, lowercase, and either title case or sentence case by selecting text and pressing [Shift]+[F3] one or more times.

Replacing Presentation Fonts
The Replace Fonts command, accessed from the Format menu, can be used to change the font for an entire presentation at once.


	Lesson Key Objective

Explain how to work with text and apply text formatting.
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Text Figures: F05-01, F05-02
Teaching Tip:
Discuss with students how they can change fonts to “squeeze in” a little extra text or fill in some extra space by changing the font without changing the font size. You may want to show them an example using both Arial Narrow and Garamond or Bookman Old Style to see the difference. Point out that two fonts of the same size always have the same height but can vary dramatically in width.

[image: image4.emf]Change the Font  Face and Font Size


Teaching Tip:

Explain the functions of the text formatting buttons on the Formatting toolbar with the help of Table 5-1.

Text Figures: F05-03, F05-04

Teaching Tip:

Inform students that the buttons used to format text and text placeholders are toggle buttons. A toggle button switches between on and off when clicked. The Bold, Italic, and Underline buttons are examples of toggle buttons.

[image: image5.emf]Use the Font Dialog  Box


Teaching Tip:

Point out that the appearance of the Bold, Underline, and Italic buttons changes when a student presses [Ctrl]+[B], [Ctrl]+[U], or [Ctrl]+[I].
Text Figure: F05-05
Teaching Tip:

Remind students they can also choose Font from the Format menu to open the Font dialog box.

Teaching Tip:

Point out that almost all Font dialog box options are available on the Formatting toolbar. Students may find the Font dialog box more convenient when applying several attributes at the same time. Note that some effects (such as superscript and subscript) do not appear on the Formatting toolbar.
Additional Notes:

Underlining is not the best way to emphasize text. It is not as easy to read as regular text because the line cuts through the bottom of letters. So emphasize your text in different ways, such as by using a larger font size, more dramatic color, or bold.
Text Figure: F05-06

Additional Notes:

You can change text attributes in the Outline pane in the same way as in the Slide pane.

Text Figure: F05-07

Teaching Tip:

If text within a placeholder is selected with the I-beam pointer, pressing [Shift]+[F3] cycles between uppercase, lowercase, and title case. If the placeholder is selected, pressing [Shift]+[F3] cycles between uppercase, lowercase, and sentence case.
Text Figure: F05-08



	Section 5.2

Applying Text Formatting to Placeholders

To apply text formatting to placeholders, users must first select the placeholder.
Selecting a Text Placeholder

Users can select placeholders in one of the following ways:

· Clicking the border of an active placeholder with the four-pointed arrow.
· Pressing [Esc] while a placeholder is active (when the insertion point is in the text).

· Pressing [Tab] to select the next placeholder on the slide (only when a text box or text placeholder is not active).
Changing Text Alignment
In PowerPoint, bulleted items, titles, and subtitles are considered paragraphs. Text in a placeholder can be aligned to the left, right, center, or justified. Users can change text alignment for all the text in a placeholder or for just one line, depending on what is selected.

Using the AutoFit Feature

AutoFit can be turned on or off using the AutoCorrect dialog box. To turn the AutoFit feature on, users can:

· Choose AutoCorrect Options from the Tools menu.

· Click the AutoFormat As You Type tab.

· Check the AutoFit title text to placeholder and the AutoFit body text to placeholder options.

	Additional Notes:
The [Tab] key can be used to cycle through all objects on a slide, not just text placeholders. If a slide contains a graphic object, [Tab] selects that as well.
Teaching Tip:

Inform students that they can deselect placeholders by pressing [Esc]. They need to press [Esc] twice if a text placeholder or text box is active. Clicking an area of the slide where there is no object also deselects an object.
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Additional Notes:

The keyboard shortcuts for increasing and decreasing font size are [Ctrl]+[Shift]+[>] and [Ctrl]+[Shift]+[<] respectively.

Teaching Tip:

Point out the difference between the border of a placeholder when it is selected and that when it is merely active. The difference is subtle.
Teaching Tip:

The Alignment command might be on the extended menu. Instruct students to choose “Alignment” and not “Font Alignment.” Font Alignment, intended for use with Asian languages, might also appear on the menu.
Teaching Tip:

Remind students that the Justify option should be reserved for longer documents such as reports when a formal appearance is required. Fully justified text is not appropriate for presentation slides.

Text Figures: F05-10, F05-11
Teaching Tip:

Discuss the advantages and disadvantages of the AutoFit feature. Remind students that all Office programs offer several methods to accomplish the same task, allowing them to individualize the way they work.
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	Section 5.3

Changing Size and Position of Text Placeholders

Users can change the size and position of text placeholders in one of the following ways:

· Dragging a sizing handle to change the size and shape of a text placeholder. 
· Dragging the placeholder border to move the text to a new position.

· Changing placeholder size and position settings by using the Format Placeholder command.

Changing the Size of a Placeholder by Dragging a Sizing Handle

To change the size or the shape of a placeholder, users must first select it. Selecting a placeholder displays the border made up of tiny dots and sizing handles. Dragging a corner sizing handle changes both the height and the width of a placeholder at the same time.

Moving a Placeholder by Dragging Its Border

The position of a placeholder can be changed by selecting the placeholder and dragging its border.
Using the Format Placeholder Command

The Format Placeholder command enables users to change the size and the placement of objects by using exact measurements. Selecting Placeholder from the Format menu opens the Format AutoShape dialog box.


	Text Figure: F05-12
Additional Notes:

To fine-tune the position of an object, press [Alt] while dragging. Another way to adjust the position of a selected object is to press the arrow keys to “nudge” an object.
Text Figure: F05-13

Teaching Tip:

Ensure students understand that to move the placeholder by dragging, they need to place the pointer over the border, not the sizing handle.
Text Figure: F05-14


[image: image9.emf]Use the Format  Placehodler Command


Teaching Tip:

Point out that one of the advantages of using the Format AutoShape dialog box for resizing placeholders is that it enables students to position and resize placeholder boxes precisely. This can be useful when students are trying to achieve uniformity among several objects.



	Section 5.4
Working with Bullets
In a body text placeholder, each line automatically begins with a bullet. Users can:

· Turn the bullets feature off.

· Remove bullets.

· Add new bullets.

· Change the shape and color of bullets.

· Create bullets from pictures.

Turning Bullets On and Off

Users can turn all the bullets in a selected text placeholder on and off using the Bullets button on the Formatting toolbar. The Bullets button on the Formatting toolbar is a toggle button. Users can also turn off just the bullets for the text selected within a placeholder.
Changing the Color and Shape of a Bullet

The Bullets and Numbering dialog box can be used to change the color and shape of a bullet. To change the shape of a bullet, users can choose a character from another font. Fonts that contain potential bullet characters include:

· Symbol
· Wingdings
· Webdings

The Geometric Shapes subset available for most fonts is another source of bullet characters.

Creating a Bullet from a Picture
A picture bullet:

· Can add a unique or creative accent to a presentation.
· Is made from a graphic file.

· Can be a company logo, a special picture, or any image created with a graphics program or captured with a scanner or digital camera.

Create Numbered Paragraphs

A numbered list is useful to indicate the order in which a series of steps should be carried out or to indicate the importance of the items in a list. Users can apply a variety of numbering styles using the Numbered tab in the Bullets and Numbering dialog box. These numbering styles include numbers, letters, and Roman numerals. Users can also create a numbered list automatically while they key body text.
	
[image: image10.emf]Change the Color  and Shape of a Bullet


Text Figures: F05-15, F05-16
Teaching Tip:

Inform students that right-clicking the placeholder border selects the border and displays the shortcut menu. It is important for the placeholder to be selected so that students can practice changing all bullets on a slide.

Teaching Tip:

Review with students how to select text for more than one bullet. To do this, students need to drag the I-beam pointer across the text, making sure that they are not dragging the four-pointed arrow.
Teaching Tip:

The Subset drop-down list is not visible for many fonts, particularly the fonts that have only bullet-type characters. For example, there is no subset option for Symbol, Wingdings, or Webdings.


[image: image11.emf]Create a Bullet from  a Picture


Additional Notes:
If the AutoFit Options button appears near the placeholder, click it and choose AutoFit Text to Placeholder.
Text Figure: F05-17

Additional Notes:

You can control the numbering style that is applied automatically by keying your first item with the style you want, such as 1 or A.


	Section 5.5
Modifying a Design Template’s Text Placeholders

A master slide contains formatted text placeholders and background items that are designed to appear on all slides in a presentation. Changes made on a master slide are reflected on all the slides in a presentation that are based on that master. There are two masters that can be used for slides:

· Title master, which includes text placeholders for the title and subtitle text of the title slide.
· Slide master, which includes text placeholders for the title and the body text.
The title master and the slide master contain the same design elements (such as background color, graphics, and text formatting). Users can change the formatting and design of the masters.
Changing Text Formatting on Master Slides
There are two ways to display the slide and title masters:

· Use the View menu.

· Press the [Shift] key and click the Normal View button.

Reapplying a Slide Layout

Changing a master does not override formatting changes made to individual slides. If users change a slide master after formatting individual slides, they can reapply the slide layout to those slides to make them conform to the new master.
	Additional Notes:

The indicator on the left side of the status bar tells whether you are viewing the slide master or the title master.
Teaching Tip:

Point out that students can size and move master placeholders just as they do slide placeholders. Students need to understand that using master slides effectively can increase their productivity because changes are made only one time and yet provide design consistency for many slides.

[image: image12.emf]Change Text  Formatting on Master Slide


Teaching Tip:

Ensure that students practice switching between the title and slide master using the vertical scroll bar, pressing the Page Up and Page Down keys, or clicking the master slide thumbnails. Stress the importance of checking the status bar to make sure they are viewing the correct master before they make changes. Additionally, stress the importance of working with both masters to produce consistently formatted presentations.

[image: image13.emf]Reapply a Slide  Layout


Teaching Tip:

You might want to introduce students to the Insert New Title Master button on the Slide Master View toolbar.
Text Figures: F05-18, F05-19



	Section 5.6
Working with Text Boxes
Users can create text boxes by clicking the Text Box button on the Drawing toolbar and then dragging the pointer to define the width of the text box.
Adding Text by Using a Text Box

The Text Box button on the Drawing toolbar enables users to create a single line of text that can be freely positioned anywhere on a slide. Users can change its color and font, and rotate it. This type of text is also called floating text.
Changing Font and Color

Users can change the font and the color of text in a text box using the same methods as those used for text placeholders.
Wrapping Text in a Text Box

Dragging the pointer to define the width of a text box automatically turns the word wrapping feature on. The height of the text box automatically adjusts to accommodate additional text lines.

Rotating a Text Box

Users can rotate PowerPoint objects, including text boxes, placeholders, and clip art, by dragging the green rotation handle that appears at the top of a selected object. The rotation of text boxes and placeholders can also be controlled using the Format Text Box and the Format AutoShape dialog boxes. To constrain the rotation of an object to 15-degree increments, users need to press [Shift] while rotating.
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Text Figure: F05-21

Teaching Tip:

Remind students that they can also select a text box by pressing [Esc] if the insertion point is active. If the insertion point is not active, they need to press [Tab] one or more times until the text box is selected.
Teaching Tip:

Explain to students that the height of the text box is not important because it usually adjusts to the amount of text keyed. This sizing characteristic can be controlled using the Format Text Box dialog box.
Additional Notes:

If you want precise positioning, right-click the text box and choose Format Text box, click the Position tab of the dialog box, and make the Horizontal setting 5.6 inches and the Vertical setting 6 inches measured from the Top Left Corner. However, if your box is wider, you may need to adjust these numbers.
Text Figure: F05-22

Text Figure: F05-23

Text Figure: F05-24

Additional Notes:

You can key a precise angle of rotation measurement on the Size tab of the Format Text Box dialog box.

Teaching Tip:

Explain to students that any object with the green rotation handle can be rotated.
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